HAWE Hydraulik SE
: PLVC Series

Supported version  TOP Design Studio v1.4.0 or higher {Rl

CONTENTS

We would like to thank our customers for using M2l's "Touch

Operation Panel (M2l TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device".

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

‘ Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 9

Describes how to set up communication for external devices.

5. cable table Page 10

Describes the cable specifications required for connection.

6. Supported addresses Page 11

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration

The system configuration of TOP and “plvc” is as follows:

Series ‘ CPU Link I/F

Communication method System setting

3.1 Settings example 1 5.1. Cable table 1
RS-232C
(Page 4) (Page 9)
PLVC Series CPU Direct
RS-422

3.2 Settings example 2 5.1. Cable table 1
(Page 5) Page 10

(4 wire)

H Connection configuration

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422/485 communication.

+ 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS422/485 communication.
) (] S—

{J [MEEE«] 0L ;'54-] .........
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device H
PLC select [COM2]
Filter : |[AII] w Search : I:I

@ Model (O Vendor

Vendor
ATLAS COPCO

TOSHIBA MACHINE Co., Ltd
GREEN POWER

ROOTECH

CKD Corparation

CSCAM

IDEC Corporation

SEHAN Electools

TOHO Electronics Inc.

IAI Corporation

MKP

TEMCOLINE Co., Ltd.

| TNMOT %

& Back | B Next X Cancel

Select Device n

PLC Setting[ PLVC Series ]

Alizs Mame @ |PLCL

Interface : | Computer Link ~

Protocol : | MC Protocol 1C ACPU ~
String Save Mode : |First LH HL Change

[ use Redundancy
AND v

Comm Manual

TimeOut 5

Condition Edit
Primary Option

Timeout 300 &|| msec

Send Wait msec

Retry

Station Num

@ Back + OK * Cancel

Settings Contents

TOP Model Check the TOP display and process to select the touch model.

External device | Vendor Select the vendor of the external device to be connected to TOP.
Select "HAWE HYDRAULIK".

PLC Select an external device to connect to TOP.

Select "HAWE PLVC".

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP Design Studio.

Project Option

-(hange HMI[H]

~ @ Option Module Setting
W FieldBus (0)
W RFID (0)
~ - Device Setting
5% COM1(0)
v ¥ COM2 (1)
-4 PLCL : PLVC Series [0]
5% COM3 (1)
W Ethernet (0)
g8 Wireless (0)
- USBDevice (0)

— AddPLC[A] | THITE Change PLCIC)

Date / Time Sync.  Screen Option

Project Option ~ Screen Change
Use HMI Setup
Hmi Setup Option

HmiSetup

E3 Delete PLCIDI

Unit Convert

Global Lock & Touch  Project Style  Splash

Initialization | Edit |

PLC Buffer Sync.

Start Mode=Menu

Start Screen No.=1

Latch Use=0

Latch Set=0~0

Commurication Error Message =0
USBErrorMessage=0
StorageErrorMessage=1
DatabaseMessage=1
SystemMessage=1
DisplayLockicon=0

A

Control Panel

System Devices @Service _'—-"'_'Uption

[ VSR e Serial x
O T
PLC Security Date/Time Serial Port: CoMz -
Signal Level
. () BS-232C () Rs-422(4) (@) RS-485(2)
cwme| &)
i Baud Rate: 38400 -
Ethernet Serial HOK I
Data Bit: & -
— Stop Bit: |1 <
& o Parity Bit: None M
Diagrost ic h'IaFnialgeer Ping Flow: 0ff
Auto Search Loopback Test
[System] Apply | Cancel
0K Cancel
Items TOP External device Remarks

Signal Level (port)

RS-232C/RS-485

RS-232C/RS-485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

M [ Project > Project Property > Device Setting > COM > “PLC1 : HAWE PLVC"]
Set the options of the HAWE PLVC communication driver in TOP Design Studio.

ERI2 e B X
Touch Qperation Panel

Project Option

*
-Change HMIH] || S Add PLC ) THTa ChangsPLCIC | [ Delete PLCID]
~ -} TOP Setting o =
T PLC Setting[ PLVC Series
-} 5Y5 : RD1520X 9l 1
W Fieldsus () Interface : | Computer Link ~
¥ RFID (0)
Device Setting Protocol : | MC Protocal 1C ACPU ~ Comm Manual
5% COM1(0) String Save Mode : [First LH HL Change
v g COM2 1
-4 PLC1: PLVC Series [0]
=% COM3 () [] use Redundancy
Ethernet (0) AND -
&9 Wireless (0) e - pe
‘.. USEDevice (0) o . =
Conditior Edi
Primary Option
Timeout 300 %[ msec
Send Wait msec
Station Num i} %
Apply Close
Items Settings Remarks
Interface “Computer Link )
Fixed
Protocol MC Protocol 1C ACPU

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP’s receiving a response from an external device and
sending the next command request.

Retry

Retry attempts upon communication failure.

Station Num

Select station number.
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

Items

Bun

YHC
Yiewer

Daty

Conitroll Panel

o Serial

Serial Port: lCDhﬂ "

Signal Level
() BS-Z32C () RS-422(4) @ RS-485(2)

Baud Rate: | 38400

|
|
[
Data Bit: |8 ~|
Stop Bit: | 1 B
[
N

-

Parity Bit: [ Mone

Flow: | (¢

-

[Auto Searchl [Loopback Test]

[ Apply H Cancel ]

o 0
TR e B
Ethernet Serial

— o
m S .

o
Diagnost ic File

Manager
[System]

TOP

Close r

External device

Remarks

Signal Level (port)

RS-232C/RS-485

RS-232C/RS-485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Main Screen > Control Panel > PLC]

Run

YNC
Yiewer

Screen
shot

’

@ Svstem | Driver(COMZ) l PLCTCFLYC Series)

-]

Protocol CMC Protocol TG ACRT + |

Interface | Computer Link
i !
FLC sq Timeout 300 2 msec

Send Wait msec

o |

T I B 515

' =

I Station b =
Ed |
Diagnost ic N
H

[Swstem] [ Diagnostic

TO,
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~
o i PLC

w’

| Aeply || Cancel |

Items Settings Remarks
Interface “"Computer Link )
Protocol Computer Link Fired
TimeOut (ms) Set the time for the TOP to wait for a response from an external device.
SendWait (ms) Set the waiting time between TOP's receiving a response from an external device and
sending the next command request.
Retry Retry attempts upon communication failure.
Station Num Select station number.
3.3 Communication diagnostics
W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].
- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.
oK Communication setting normal
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Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system oK NG ) )
. . - 1. System configuration
configuration Connection cable name oK NG
TOP Version information oK NG
Port in use oK NG
Driver name oK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
. . oK NG . )
diagnostics 3. Communication setting
Serial Parameter Transmission
oK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit OK NG
External device CPU name oK NG
Communication port name (module
oK NG
name)
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings oK NG 4. External device setting
Serial Parameter Transmission
oK NG
Speed
Data Bit oK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
oK NG (For details, please refer to the PLC

vendor's manual.)
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4. External device setting

Configure the communication setting of the external device by referring to its user manual.
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5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.)

W RS-232C (1:1 connection)

COM PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) | name | number name
1 5 CD 1
(o} o} RD 2 SD
6 9 DTR 4 DTR
Based on G 5 G
communication cable DSR 6 DSR
connector' front, RTS - RTS
D-SUB 9 Pin male TS 8 TS
(male, convex) 5

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-422 (1:1 connection)

COM PLC

Pin Signal Pin Cable connection Signal

arrangement*Note 1) | name | number name

1 5 RDA(+) 1 SDA(+)

(o) e} 2 SDB(-)

6 9 RDB(-) 4 RDB(-)

Based on G 5 G

communication cable SDA(+) 6
connector front, -
D-SUB 9 Pin male 8
(male, convex) SDB() 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

COM PLC

Pin Signal Pin Cable connection Signal

arrangement*Note 1) | name number name

3 5 RDA(+) 1 SDA(+)

Q o 2 SDB(-)

6 9 RDB(-) 4 RDB(-)

Based on G 5 G
communication cable SDA(+) 6 o

connector front, -
D-SUB 9 Pin male 8
(male, convex) SDB() 3

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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6. Supported addresses

The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address
range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the
address range supported by the device you want to use.

Type Remarks Bit-designated address Word-designated address
Input relay Bit X0000 — X1FFF X0000 — X1FFO
Output relay Bit Y0000 - Y1FFF Y0000 - Y1EEQ
Internal relay Bit M0000.00-M9999.15 M0000-M9999
Timer (contact) Bit T0000.00-T9999.15 T0000-T9999
Counter (contact) Bit €0000.00-C9999.15 C0000-C9999
Link relay Bit B0O00O — B1FFF B0OOOO — B1FFO
Special relay Bit F0000.00-F9999.15 FOO00—-F9999
Timer value Word TV000.00-TV999.15 TV000-TV999
Counter value Bit CV000.00-CV999.15 CV000-CV999
Data register Bit D0000.00-D9999.15 D0000-D9999
Link register Word W0000 - W1FFF W0000 — W1FFO
Extend register Bit R0000.00-R9999.15 R0000-R9999
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